
Instruction Manual 
[Simple Operation]

Notice

This manual explains basic operating procedures to enable first-time users to quickly 

use the system.

For more details, please refer to the included instruction manual [Hardware] and the 

software [Online Help]. Retain this instruction manual for future reference.

VS120-S5-W 
VS120-S6-W 
VS120-L100-W

Virtual Slide System
VS120

Optical Microscope and Accessory



ii

VS120

Introduction...............................................................................................................1

1 Acquiring Images  L100 Type...............................................................3

1-1 Starting the microscope system............................................................................................................. 3

1-2 Setting a slide.......................................................................................................................................................... 4

1-3 Acquiring image in each scan mode................................................................................................. 5

1 	 Brightfield quick mode..............................................................................................................................................................5

2  	Brightfield expert mode............................................................................................................................................................7

3 	 Brightfield quick batch mode........................................................................................................................................... 10

4 	 Brightfield expert batch mode......................................................................................................................................... 12

5 	 Fluorescence expert mode................................................................................................................................................15

6 	 Fluorescence expert batch mode................................................................................................................................20

1-4 Closing the microscope system..........................................................................................................24

2 Acquiring Images  S5 Type..................................................................25

2-1 Starting the microscope system.........................................................................................................25

2-2 Setting a slide......................................................................................................................................................25

2-3 Acquiring image in each scan mode.............................................................................................26

1 	 Brightfield quick mode...........................................................................................................................................................26

2 	 Brightfield expert mode.........................................................................................................................................................28

3 	 Brightfield quick batch mode...........................................................................................................................................31

4 	 Brightfield Expert Batch Mode........................................................................................................................................33

5 	 Fluorescence expert mode................................................................................................................................................36

6 	 Fluorescence expert batch mode................................................................................................................................41

2-4 Closing the microscope system.........................................................................................................45

Contents



iii

VS120

3 Acquiring Images  S6 Type..................................................................46

3-1 Starting the microscope system.........................................................................................................46

3-2 Setting a slide......................................................................................................................................................46

3-3 Acquiring image in each scan mode............................................................................................. 47

1 	 Brightfield quick mode...........................................................................................................................................................47

2 	 Brightfield expert mode.........................................................................................................................................................49

3 	 Brightfield quick batch mode...........................................................................................................................................52

4 	 Brightfield Expert Batch Mode........................................................................................................................................54

5 	 Fluorescence expert mode................................................................................................................................................57

6 	 Fluorescence expert batch mode................................................................................................................................62

3-4 Closing the microscope system.........................................................................................................66

4 Acquiring Images  Explanation of Functions.......................67

4-1 Operating the joystick...................................................................................................................................67

4-2 Setting a slide (L100 Type)........................................................................................................................67

4-3 Saving acquired images.............................................................................................................................68

4-4 Selecting slides to apply scan settings........................................................................................68

4-5 Setting options....................................................................................................................................................69

4-6 Setting Z scan mode..................................................................................................................................... 70

4-7 Scanning labels.................................................................................................................................................. 70

4-8 Editing scan area...............................................................................................................................................71

4-9 Editing focus maps......................................................................................................................................... 72

4-10 Setting focus mode...................................................................................................................................... 73

4-11 Priority scanning...............................................................................................................................................74

4-12 Operating each fluorescence channel....................................................................................... 75

1 	 Adjusting exposure time.......................................................................................................................................................75

2 	 Setting Z offset..............................................................................................................................................................................76

3  	Adjusting histogram after acquiring image.........................................................................................................77



iv

VS120

CAUTION

This software and manual may not be used or copied in whole or in part without permission.

Registered trademark

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States.

Other company and product names are trademarks or registered trademarks of the respective company.

5 Using Scan Projects .......................................................................................................... 78

5-1 Saving scan projects..................................................................................................................................... 78

5-2 Loading scan projects.................................................................................................................................. 79

5-3 Editing scan projects..................................................................................................................................... 79

6 Editing Images ............................................................................................................................80

6-1 Trimming images and saving as TIFF.............................................................................................80

6-2 Copying and transferring images to other mediums.......................................................80

6-3 Changing image names............................................................................................................................. 81

7 Maintenance.....................................................................................................82

7-1 Shading correction...........................................................................................................................................82

1 	 Brightfieldcamera shading correction......................................................................................................................82

2 	 Fluorescencecamera shading correction.............................................................................................................85

7-2 Setting overview image area..................................................................................................................92

7-3 Setting label area..............................................................................................................................................94

8 Saving and Restoring the System .......................................................................................96

8-1 Saving the system............................................................................................................................................96

8-2 Restoring the system....................................................................................................................................96



1

VS120

Introduction

This system constructs a digitized high-resolution image of a part or whole of a slide glass specimen. Three different 

types are provided according to whether slide glass specimens are transferred manually or automatically and the 

number of slide glass specimens transferrable at one time: (1) 5 slides manual loading type, (2) 6 slides manual loading 

type, and (3) 100 slides autoloader type.

Configuration of instruction manuals

Since this microscope is expandable to a variety of systems, separate instruction manuals are prepared so that the 

user has to read only the manuals according to the user’s own system.

Instruction manual Main content

VS120 Instruction Manual 

[Simple Operation]  

(this manual)

Regarding method for operations such as acquiring and editing images

VS120 Instruction Manual 

[Hardware] 

Notices regarding safety, explanation of main operating parts, 

specifications etc.

VS120 Online Help Instructions on operation of software

BX-UCB Instruction Manual About microscope control box

U-UCD8A Instruction Manual About motorized universal condenser

VS-RFAA Instruction Manual About motorized reflected fluorescence illuminator

If the product is used in a manner not specified by this manual, the safety of the user may be imperiled. In addition, the 

product may also be damaged. Always use the product as outlined in this instruction manual.

The following symbols are used in this instruction manual.

 CAUTION :	 Indicates a potentially hazardous situation which, if not avoided, may result in minor 

or moderate injury. 

NOTE  :	 Indicates a potentially hazardous situation which, if not avoided, may result in 

damage to the equipment or other property.

TIP  :	 Indicates commentary (for ease of operation and maintenance).

    : Indicates the reference page where the function is described in detail. 
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Handling precautions 

·· Be careful not to bump the microscope system during scanning.

·· Do not touch the image such as opening files, zooming or panning during scanning.  

There is a risk that the scan operation will become unstable.

·· Set the cover glass up (objective lens side). If mounted upside-down, it will not be possible to focus on the specimen.

·· When moving slides of different thickness manually, because it may interfere with the 40x or higher objective lens, 

please move the slide after moving the objective lens to standby or switching to a low-magnification objective.

·· When setting the slide specimen on the stage, 

[L100 type]	 Set the slide specimen such that its longer side faces the front with the label on the left side. 

[S5 type]	 Set the slide specimen such that its shorter side faces the front with the label at the front. 

[S6 type]	 Set the slide specimen such that its longer side faces the front with the label on the right side.

·· If you want to restart the VS-ASW after closing it, please wait at least 10 seconds before restarting.   

There is a risk that settings made at the time of closing may not be reflected properly.

·· If you want to apply settings with the batch scan mode [Scan Settings], please apply after having set all the settings.  
In addition, after changing settings under options etc., please re-apply the settings.  
If you do not apply the settings, the settings immediately prior and the changed contents will not be reflected.   
Please observe special caution when changing the settings immediately prior to a [Scan Now] operation.
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1 Acquiring Images  L100 Type

1-1 Starting the microscope system

VS-ASW-L100

1
First, turn on the monitor, followed by the microscope control box, 

slide loader, and controller to start up the system. 

If a fluorescence image is acquired, please switch on the 

power of a peripheral device such as a fluorescence light 

source.

After Windows® starts, enter your user name and password.

Please consult with the system administrator regarding user 

name and password.

After the system has started up, double click the [VS-ASW] icon on the 

desktop to start up the software and begin adjustment of the stage.  

1

TIP

2

TIP

3
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Acquiring Images  L100 Type ﻿

1

25
26

50

Set the slide in the cassette.

·· Before setting the slide in the cassette, please wipe the 
slide clean of any dust etc.

·· Hold the slide specimen with the label on the front side, 
with the cover glass side in the direction of handle @ 
(direction becomes upwards when setting the slide loader) 
to set a slide.

Open the slide loader cassette cover.

Please take care when opening or closing the cassette 
cover that you do not trap your fingers.

Set the cassette in the specified position in the loader.

Close the slide loader cassette cover.

For details, refer to “4-2 Setting a slide (L100 Type)” on page 67 

and the instruction manual [Hardware] “2-3 Setting a slide glass 

specimen".

1

NOTE

2

CAUTION

3

4

TIP

Cassette 1

Cassette 2

@

3

1-2 Setting a slide

2
4
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Acquiring Images  L100 Type 	 Brightfield quick mode

1 	 Brightfield quick mode

Acquire a specimen image without detailed settings.

Select  from the top right of the screen.

Click .

Click .

The stage moves to the front right, and the [VS-ASW] dialog box displays 

a [Please insert a new slide.] message.

Set the slide in the stage, click  of the [VS-ASW] 

dialog box.   

The stage will then move back to its original position.

 4-2 Setting a slide (L100 Type) (page 67)

If necessary, input the slide information.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click .

1

2

3

24

5

6

7

1

2

3

1-3 Acquiring image in each scan mode

4

5
6 7
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Acquiring Images  L100 Type 	 Brightfield quick mode

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

If necessary, change the [Scan Settings] with .

 4-5 Setting options (page 69)

Click .

If the arrow to the side of the button is clicked, an image of the 

slide label can be acquired.

 4-7 Scanning labels (page 70)

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  (remove slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and bright field quick mode closes.

8

9

10

11

TIP

12

13

8

9
11

12
13

10
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Acquiring Images  L100 Type  	 Brightfield expert mode

Acquire a specimen image by setting the objective lens (magnification), 

scan area (XY) and focus.

Select  from the top right of the screen.

Click .

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage, click  of the [VS-ASW] dialog 

box.  

The stage will then move back to its original position.

 4-2 Setting a slide (L100 Type) (page 67)

If necessary, input the slide information.

Click  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

If the arrow to the side of the button is clicked, an image of the 

slide label can be acquired.

 4-7 Scanning labels (page 70)

The specimen image is scanned by the 2x objective lens.

1

2

3

24

5

6

7

TIP

1

2

3

2  	 Brightfield expert mode

6
5 7

4
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Acquiring Images  L100 Type  	 Brightfield expert mode

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

Click .

Click  to edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click  (automatic focus).

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

8

9

10

11

12

13

14

15

8

9
10

11 12

13
14

15
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Acquiring Images  L100 Type  	 Brightfield expert mode

When scanning is complete, the screen shown on the left is 

displayed.

If necessary, save files.

Click  (remove slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and brightfield expert mode closes.

16

17

16
17
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Acquiring Images  L100 Type 	 Brightfield quick batch mode

Acquire multiple images of slide specimens using the slide loader 

without detailed settings.  

First, please set the slide specimens in the inserted cassette.

Select  from the top right of the screen.

Click .

After clicking the button, please do not open or close the 
cassette cover.

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .

1

2

NOTE

3

TIP

4

1

2

3 	 Brightfield quick batch mode

3 4
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Acquiring Images  L100 Type 	 Brightfield quick batch mode

Select the slide to apply settings and click the objective lens 

(magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click  (apply settings to all slides in cassette).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and brightfield quick batch mode closes.

Click  and the results of the batch scan (log file) can be 

viewed.

5

6

7

8

9

TIP

9

57 8
6
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Acquiring Images  L100 Type 	 Brightfield expert batch mode

Using the slide loader, acquire multiple slide specimen images by setting 

the objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens in the inserted cassette.

Select  from the top right of the screen.

Click .

After clicking the button, please do not open or close the 
cassette cover.

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .

1

2

NOTE

3

TIP

4

1

2

4 	 Brightfield expert batch mode

3 4
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Acquiring Images  L100 Type 	 Brightfield expert batch mode

5 6

Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

The [Focus Settings] tab is displayed.

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

 4-9 Editing focus maps (page 72)

Click  (apply settings to all slides in cassette).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.

5

6

7

8

9

10

TIP

8

1079
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Acquiring Images  L100 Type 	 Brightfield expert batch mode

Click  (select all slides in list).

Click  and edit the scan region on the displayed screen.

 4-8 Editing scan area (page 71)

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and brightfield expert batch mode closes.

Click  and the results of the batch scan (log file) can be 

viewed.

11

12

13

14

15

16

TIP

14 15

16

13

11
12
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Acquiring Images  L100 Type 	 Fluorescence expert mode

1

2

Acquire a fluorescence image by setting the objective lens 

(magnification), scan area (XY) and focus.

Operation may differ depending on your model, please also 

consult the Online Help.

Select  from the top right of the screen.

Click .

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage, click  of the [VS-ASW] dialog 

box.  

The stage will then move back to its original position.

 4-2 Setting a slide (L100 Type) (page 67)

If necessary, input the slide information.

Select  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

TIP

1

2

3

24

5

6

7

3

5
76

5 	 Fluorescence expert mode

4
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Acquiring Images  L100 Type 	 Fluorescence expert mode

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 

Low brightness areas are not recognized.

Cells

Fluorescence overview image 

Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

Click  and display the image.

Set the exposure time while looking at the image.

 Adjusting exposure time (page 75)

After live is finished, click  .

If the arrow to the side of the button is clicked, an image of 

the slide label can be acquired.

 4-7 Scanning labels (page 70)

8

9

10

11

TIP

9

118 10
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Acquiring Images  L100 Type 	 Fluorescence expert mode

12
13

Click the objective lens (magnification) button.

Click either Z scan mode (standard) Z mode, (virtual Z) Z mode, 

(EFI) Z mode, or (MIP) Z mode.

 4-6 Setting Z scan mode (page 70)

Click .

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .

12

13

14

15

16

14

1615
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Acquiring Images  L100 Type 	 Fluorescence expert mode

Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .

Click  (manual exposure time mode).

Select the channel and the image is displayed with .

Click .

After adjusting the specimen position and focus with the joystick, 

set the exposure time with the  and  buttons.

 Adjusting exposure time (page 75)

Live will stop after each channel.

If necessary, set Z offset.

Click  to enable Z offset.

 Setting Z offset (page 76)

Click .

17

TIP

18

19

20

21

22

23

17
18

22 23

2021

19
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Acquiring Images  L100 Type 	 Fluorescence expert mode

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  and edit the focus map.

 4-9 Editing focus maps (page 72)

Select (manual focus).

Click .

While viewing the live image, bring the specimen into focus at all 

focus points.

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is displayed.

Click  (unload slide).

The stage moves to the front right.

Click  and fluorescence expert mode closes.

24

25

1826

27

28

29

30

31

31

24

26

29

30

28

2725
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Acquiring Images  L100 Type 	 Fluorescence expert batch mode

1

2

6 	 Fluorescence expert batch mode

Acquire multiple fluorescence slide images using the slide loader by setting 

the objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens in the inserted cassette.

Select  from the top right of the screen.

Click .

After clicking the button, please do not open or close the 
cassette cover.

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .

1

2

NOTE

3

TIP

43 4
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Acquiring Images  L100 Type 	 Fluorescence expert batch mode

Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

The [Overview Settings] tab is displayed.

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 

Low brightness areas are not recognized.

Cells

Fluorescence overview image 

Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

The [Illumination Settings] tab is displayed.

Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .

5

6

7

8

9

10

11

TIP

65

8
9

7

1011
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Acquiring Images  L100 Type 	 Fluorescence expert batch mode

The [Focus Settings] tab is displayed.

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  (apply settings to selection) or  (apply settings to all 

slides in cassettes).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.

12

13

14

15

TIP

15

13

1214
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Acquiring Images  L100 Type 	 Fluorescence expert batch mode

23

Click  (select all slides in list).

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

The [Illumination Settings] tab is displayed.

Click  (automatic exposure time mode).

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and fluorescence expert batch mode 

closes.

Click  and the results of the batch scan (log file) can be 

viewed.

16

17

18

19

20

21

22

23

TIP

17

20

22

16

18

19

21
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Acquiring Images  L100 Type

Open the slide loader cassette cover.

Please take care when opening or closing the cassette 
cover that you do not trap your fingers.

Remove the cassette.

Close the slide loader cassette cover.

Place your finger on cassette door @ and lightly lift up to open, then 

remove all specimens and close cassette door @.

Regarding how to unload slides, please also refer to 

instruction manual [Hardware] “2-3 Setting a slide glass 

specimen".

Click the  button in the VS-ASW screen top right.

Shutdown Windows®.

The controller powers OFF. The connected monitor, microscope control 

box and slide loader also power OFF.

Switch the controller main switch OFF.

If you have acquired the fluorescence image, turn OFF the power 

of the light source for fluorescence and other peripherals.

1

CAUTION

2

3

4

TIP

5

6

7

TIP

@

2

1-4 Closing the microscope system

3
1

5
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2-1 Starting the microscope system

First, turn on the monitor, followed by the microscope control box, 

slide loader, and controller to start up the system.  

If a fluorescence image is acquired, please switch on the 

power of a peripheral device such as a fluorescence light 

source.

After Windows® starts, enter your user name and password.

Please consult with the system administrator regarding user 

name and password.

After the system has started up, double click the [VS-ASW] icon on the 

desktop to start up the software and begin adjustment of the stage.  

1

TIP

2

TIP

3VS-ASW

1

Pull the specimen holder open/close slider @ towards you, and with 

the specimen holder open, set the slide specimen.

Set the specimen such that its shorter side faces the front and the 
label ² is toward the front.

Please observe caution not to touch the objective lens.

Gently return the specimen holder open/close slider and confirm that 

the specimen has been correctly set.

Set as many specimens as required.

Regarding how to set the slide, please also refer to the instruction 

manual [Hardware] “2-3 Setting a slide glass specimen".

1

NOTE

2

3

TIP

@

²

     

2 Acquiring Images  S5 Type

2-2 Setting a slide
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Acquiring Images  S5 Type 	 Brightfield quick mode

1 	 Brightfield quick mode

Acquire a specimen image without detailed settings.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box displays 

a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.

1

2

3

4

5

6

1

2

5

4

3

2-3 Acquiring image in each scan mode

6
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Acquiring Images  S5 Type 	 Brightfield quick mode

If necessary, input the slide information.

Click the automatic save button  (to disk) and specify the file 

destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click .

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

If necessary, change the [Scan Settings] with .

 4-5 Setting options (page 69)

Click .

If the arrow to the side of the button is clicked, an image of the 

slide label can be acquired.

 4-7 Scanning labels (page 70)

Scanning starts.

When scanning is complete, the screen shown on the left is displayed.

Click  (unload slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and bright field quick mode closes.

7

8

9

10

11

12

13

TIP

14

15

11
13

12

987

14
15

10
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Acquiring Images  S5 Type 	 Brightfield expert mode

1

2

5

4

3

Acquire a specimen image by setting the objective lens (magnification), 

scan area (XY) and focus.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.

1

2

3

4

5

6

2 	 Brightfield expert mode

6
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Acquiring Images  S5 Type 	 Brightfield expert mode

If necessary, input the slide information.

Select  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

If the arrow to the side of the button is clicked, an image of 

the slide label can be acquired.

 4-7 Scanning labels (page 70)

The specimen image is scanned by the 2x objective lens.

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

Click .
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Click  to edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Select  (automatic focus).

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

If necessary save files.

Click  (remove slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and brightfield expert mode closes.

13

14

15

16

17

18

19

13 14

19
18

15
16

17



VS120

31

Acquiring Images  S5 Type 	 Brightfield quick batch mode

Acquire multiple images of slide specimens set on the stage without 

detailed settings.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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3 	 Brightfield quick batch mode
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Select the slide to apply settings and click the objective lens 

(magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click  (apply settings to all slides in cassette).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

Scanning starts.

Click  and scanning stops.

Click  and the results of the batch scan (log file) can be 

viewed.
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Acquire multiple images of slide specimens set on the stage by setting the 

objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click  (apply settings to selection) or  (apply settings to all 

slides in cassettes).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.
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Click  (select all slides in list).

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and brightfield expert batch mode closes.

Click  and the results of the batch scan (log file) can be 

viewed.
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1

2

Acquire a fluorescence image by setting the objective lens 

(magnification), scan area (XY) and focus.

Operation may differ depending on your model, please also 

consult the Online Help.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.

TIP
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If necessary, set the slide information.

Select  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 
Low brightness areas are not recognized.

Cells

Fluorescence overview image 
Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

Click  and display the image.

Set the exposure time while looking at the image.

 Adjusting exposure time (page 75)

Stop live then click .

If the arrow to the side of the button is clicked, an image of 

the slide label can be acquired.

 4-7 Scanning labels (page 70)
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Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode,  (EFI) Z mode, or  (MIP) Z mode.

 4-6 Setting Z scan mode (page 70)

Click .

Click  to edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .
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Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .

Click  (manual exposure time mode).

Select the channel and the image is displayed with .

Click .

After adjusting the specimen position and focus with the joystick, set 

the exposure time with the  and  buttons.

 Adjusting exposure time (page 75)

Live will stop after each channel.

If necessary, set Z offset.

Click  to enable Z offset.

 Setting Z offset (page 76)

Click .
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33

29
26

28

27

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  and edit the focus map.

 4-9 Editing focus maps (page 72)

Select  (manual focus).

Click .

While viewing the live image, bring the specimen into focus at all 

focus points.

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is displayed.

Click  (unload slide).

The stage moves to the front right.

Click  and fluorescence expert mode closes.
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6 	 Fluorescence expert batch mode

Acquire multiple images of slide specimens set on the stage by setting 

the objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

The [Overview Settings] tab is displayed.

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 

Low brightness areas are not recognized.

Cells

Fluorescence overview image 

Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

The [Illumination Settings] tab is displayed.

Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .
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The [Focus Settings] tab is displayed.

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  (apply settings to selection) or  (apply settings to all 

slides of all cassettes).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.
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Click  (select all slides in list).

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

The [Illumination Settings] tab is displayed.

Click  (automatic exposure time mode).

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and fluorescence expert batch mode 

closes.

Click  and the results of the batch scan (log file) can be 

viewed.
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Move the stage to the front by operating the joystick lever.

 4-1 Operating the joystick (page 67)

Remove the slide.

Click the  button in the VS-ASW screen top right.

Shutdown Windows.

The controller powers OFF. The connected monitor and microscope 

control box also power OFF.

Switch the controller main switch OFF.

If you have acquired the fluorescence image, turn OFF the power 

of the light source for fluorescence and other peripherals.
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TIP

2-4 Closing the microscope system
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3-1 Starting the microscope system

VS-ASW

Open the specimen holder by sliding the specimen holder open/close 

slider @ to the left. Set a slide glass specimen in place.

Set a slide glass specimen such that its longer side faces the front 
and the label ² is on the right side. 

Take care that you do not touch the objective lens.

Gently return the specimen holder open/close slider back to its original 

position and check that the specimen is securely seated and not tilted.

Set the required number of slide glass specimens in the same manner 

as described in 1  and 2 .

Regarding how to set the slide, please also refer to the instruction 

manual [Hardware] “2-3 Setting a slide glass specimen".

1

NOTE

2

3

TIP

3 Acquiring Images  S6 Type

3-2 Setting a slide

1

 
²

@

First, turn on the monitor, followed by the microscope control box, 

slide loader, and controller to start up the system. 

If a fluorescence image is acquired, please switch on the 

power of a peripheral device such as a fluorescence light 

source.

After Windows® starts, enter your user name and password.

Please consult with the system administrator regarding user 

name and password.

After the system has started up, double click the [VS-ASW] icon on the 

desktop to start up the software and begin adjustment of the stage.  
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1 	 Brightfield quick mode

Acquire a specimen image without detailed settings.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box displays 

a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.
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If necessary, input the slide information.

Click the automatic save button  (to disk) and specify the file 

destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click .

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

If necessary, change the [Scan Settings] with .

 4-5 Setting options (page 69)

Click .

If the arrow to the side of the button is clicked, an image of the 

slide label can be acquired.

 4-7 Scanning labels (page 70)

Scanning starts.

Clicking the  enables to escape or restore the objective in 

order to drop or wipe the immersion oil.

Once you have applied immersion oil and wiped the stage, 

click  in the dialog box.

The stage will then move back to its original position.

When scanning is complete, the screen shown on the left is displayed.

Click  (unload slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and bright field quick mode closes.
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1

2

Acquire a specimen image by setting the objective lens (magnification), 

scan area (XY) and focus.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.

Click .
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If necessary, input the slide information.

Select  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

If the arrow to the side of the button is clicked, an image of 

the slide label can be acquired.

 4-7 Scanning labels (page 70)

The specimen image is scanned by the 2x objective lens.

Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode, or  (EFI) Z mode.

 4-6 Setting Z scan mode (page 70)

Clicking the  enables to escape or restore the objective in 

order to drop or wipe the immersion oil.

Once you have applied immersion oil and wiped the stage, 

click  in the dialog box.

The stage will then move back to its original position.

Click .
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Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Select  (automatic focus).

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

If necessary save files.

Click  (unload slide).

The stage moves to the front right.

Remove the slide following the [VS-ASW] dialog box messages.

The stage will then move back to its original position.

Click  and brightfield expert mode closes.
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Acquire multiple images of slide specimens set on the stage without 

detailed settings.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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Select the slide to apply settings and click the objective lens 

(magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click  (apply settings to all slides in cassette).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

Scanning starts.

Click  and scanning stops.

Click  and the results of the batch scan (log file) can be 

viewed.
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Acquire multiple images of slide specimens set on the stage by setting the 

objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

Click  (apply settings to selection) or  (apply settings to all 

slides of all cassettes).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.
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Click  (select all slides in list).

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and brightfield expert batch mode closes.

Click  and the results of the batch scan (log file) can be 

viewed.
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1

2

Acquire a fluorescence image by setting the objective lens 

(magnification), scan area (XY) and focus.

Operation may differ depending on your model, please also 

consult the Online Help.

Select  from the top right of the screen.

Click .

Select the slot number to set the slide.

Click .

The stage moves to the front right, and the [VS-ASW] dialog box 

displays a [Please insert a new slide.] message.

Set the slide in the stage.

Click  in the [VS-ASW] dialog box. 

The stage will then move back to its original position.

TIP
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If necessary, set the slide information.

Select  (disable automatic save).

 4-3 Saving acquired images (page 68)

Click .

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 
Low brightness areas are not recognized.

Cells

Fluorescence overview image 
Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

Click  and display the image.

Set the exposure time while looking at the image.

 Adjusting exposure time (page 75)

Stop live then click .

If the arrow to the side of the button is clicked, an image of 

the slide label can be acquired.

 4-7 Scanning labels (page 70)
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Click the objective lens (magnification) button.

Click either Z scan mode  (standard) Z mode,  (virtual Z) Z 

mode,  (EFI) Z mode, or  (MIP) Z mode.

 4-6 Setting Z scan mode (page 70)

Clicking the  enables to escape or restore the objective in 

order to drop or wipe the immersion oil.

Once you have applied immersion oil and wiped the stage, click 

 in the dialog box.

The stage will then move back to its original position.

Click .

Click  to edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

Click .
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Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .

Click  (manual exposure time mode).

Select the channel and the image is displayed with .

Click .

After adjusting the specimen position and focus with the microscope 

joystick, set the exposure time with the  and  buttons.

 Adjusting exposure time (page 75)

Live will stop after each channel.

If necessary, set  Z offset.

Click  to enable Z offset.

 Setting Z offset (page 76)

Click .
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34
33

26

28

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  and edit the focus map.

 4-9 Editing focus maps (page 72)

Select (manual focus).

Click .

While viewing the live image, bring the specimen into focus at all 

focus points.

 4-10 Setting focus mode (page 73)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is displayed.

Click  (unload slide).

The stage moves to the front right.

Click  and fluorescence expert mode closes.
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6 	 Fluorescence expert batch mode

Acquire multiple images of slide specimens set on the stage by setting 

the objective lens (magnification), scan area (XY) and focus.

First, please set the slide specimens on the stage.

Select  from the top right of the screen.

Click .

If necessary, input the slide information.

Select the slide with , and input the slide information in .

Leave slides which do not need information blank.

Click .
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Click the objective lens (magnification) button.

Click the automatic save settings button  (to disk) and specify the 

file destination for the acquired image.

 4-3 Saving acquired images (page 68)

The [Overview Settings] tab is displayed.

Select the observation mode for acquiring image from the following.

BF (Brightfield)

Brightfield overview image

Tissue

Fluorescence overview image 

Low brightness areas are not recognized.

Cells

Fluorescence overview image 

Low brightness areas can also be recognized.

Click the arrow next to the selected button, and choose the 
acquisition channel (FL Red, FL Blue, FL Green) from the pulldown 
menu.

Select the objective lens (magnification) to use for the overview. 

(Normally select 2x.)

The [Illumination Settings] tab is displayed.

Click  and add the channel to be used for scanning.

Focus operates based on No.1 channel. Please move the 

channel suitable for focus to No.1 with .
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The [Focus Settings] tab is displayed.

Select the focus map grid density.

(Normally, select the  (normal) at the middle.)

Click  (apply settings to selection) or  (apply settings to all 

slides of all cassettes).

The slide to which the settings are applied is highlighted in the color 

corresponding to the objective lens (magnification) selected in 5 .

 4-4 Selecting slides to apply scan settings (page 68)

Click .

An overview image for the specified number of slides is 

scanned.  

Please wait a moment for the scanning to complete.
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23

Click  (select all slides in list).

Click  and edit the scan area on the displayed screen.

 4-8 Editing scan area (page 71)

The [Illumination Settings] tab is displayed.

Click  (automatic exposure time mode).

The [Focus Settings] tab is displayed.

Click  and edit the focus map on the displayed screen.

 4-9 Editing focus maps (page 72)

Click .

Scanning starts.

When scanning is complete, the screen shown on the left is 

displayed.

Click  and fluorescence expert batch mode closes.

Click  and the results of the batch scan (log file) can be 

viewed.

16

17

18

19

20

21

22

23

TIP
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Move the stage to the front by operating the joystick lever.

 4-1 Operating the joystick (page 67)

Remove the slide.

Click the  button in the VS-ASW screen top right.

Shutdown Windows.

The controller powers OFF. The connected monitor and microscope 

control box also power OFF.

Switch the controller main switch OFF.

If you have acquired the fluorescence image, turn OFF the power 

of the light source for fluorescence and other peripherals.

1

2

3

4

5

TIP

3-4 Closing the microscope system

3
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4-1 Operating the joystick

4-2 Setting a slide (L100 Type)

To set slide on the stage manually :

The stage automatically moves to a position where you can easily insert 

a new slide. At the same time, a dialog box, requesting you to insert the 

microscope slide, will open.

Pull the specimen holder open/close slider @ towards you, and with the 

specimen holder open, set the slide specimen.  
Set the specimen such that its longer side faces the front and with the 
label ² on the left side.

Gently return the specimen holder open/close slider and confirm the 

operation with [OK].

To set slide from the slide loader :

Click  and the [Load Slide from Slide Loader] dialog box is 

displayed, and the position where the slide is set is detected.

Empty trays without slides are marked with an X.

When setting slides from the slide loader, please be sure 
to confirm that there are no slides on the stage.

TIP

NOTE

@²

Operate the lever to move the stage.

The stage can be moved at 4 different speeds.

Level 1 Level 2 Level 3 Level 4

Slow Fast

: Press the button and the level increases.
(When at level 4, if the button is pressed the speed returns to level 1)

: the number of times the LED light flashes changes according to 
the level.
(Level 1:  1 flash, ..., Level 4:  4 flashes)

: If you press the button while turning the lever, the stage will move 
at level 4 speed. 

: Not In Use

4 Acquiring Images  Explanation of Functions

L100 type 
S5 type

S6 type
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4-3 Saving acquired images

You can select whether to save the image automatically after acquiring the image, or save the image by specifying the 

save destination after acquiring the image.

Also, if saving automatically, you can set the save method. 

Select one of the following buttons from [Destination] in the [Slide 

Properties] step.

 The image is not automatically saved, and the image 

window is displayed. The displayed image can be saved at 

any time specifying the save destination and file type etc.

 Saved automatically to the specified disk. 

Click  button at [Location] , and set the image save 

location on the displayed screen.

 Saved automatically to the specified database. 

The [Open Database] dialog box is displayed. Set the image 

save location on the displayed screen.

·· The save method and location can also be specified from 

[Scan Settings]→[Images] under the option.

·· Click  button at [Image Name], and the automatically 

applied name can be changed. For more details, please refer 

to the Online Help.

TIP

4-4 Selecting slides to apply scan settings

Load previously saved scan settings and use for scanning.

Apply current scan settings to all slides.

Apply current scan settings to slides selected from the slide list 

on the left.

Load scan settings of slides selected from the slide list on the 

left.

Delete scan settings for slides selected from the slide list on 

the left.

When performing batch scanning, you can select which slides to apply the current scan settings.

Also, you can load and use previously saved scan settings.
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4-5 Setting options

Specimen detection settings

·· Scan area settings

Auto adjust scan area

Select from the following 2 scan modes.

 When scanning 1 scan area

 When scanning multiple scan areas

Use predefined scan area

Loading a saved scan area.  
Click the arrow to the side of the box, and from the list select the 
scan area to be used.

Detailed scan settings

·· Detail scan parameter

Select from the following 3 options.

 Focusing and scanning only the specimen inside the area. 
The processing speed is faster, but areas not recognized as 
specimen will not be scanned.

 Scanning the whole area and focusing only on the specimen. 
Areas not recognized as specimen will not be focused.

 Scanning and focusing the whole area. 
All areas of the slide where the presence of specimens is hard 
to recognize are focused. 

Focus map settings

·· Grid density

Focus map grid density can be selected from 5 types:

[Extra Low], [Low], [Standard], [High], [Extra high].

1

2

3

2

3

Scan settings such as "Scan Area", "Detailed Area" and "Focus Map" can be changed.

1
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4-6 Setting Z scan mode

Select Z scan mode.

[Standard] Z mode
Acquire a standard detail scan.

[Virtual-Z] Z mode
Acquire an image by changing the focal position in the 
height (Z) direction. 

[EFI] (Expanded Focus Image) Z mode
Images with the highest sharpness value are acquired.

[MIP] (Maximum Intensity Projection) Z mode [fluorescence 
scan mode only]
Images with the highest brightness are acquired.

Selecting ,  and , will displayed Z Interval, Z Range, and 

plane count setting buttons at the bottom.  

If necessary enter the value.

Initial settings are set to automatic. If setting manually, 

please uncheck the checkbox.

1

2

TIP

Brightfield scan mode

1

2

Fluorescence scan mode

1

2

4-7 Scanning labels

Click the  or  button side tab and 

enter a check in [Scan Label].

The icon above the button changes from  to .

1

2

Slide information such as bar codes can be acquired together with a specimen image.
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4-8 Editing scan area

Click .

Operate the  mark to edit the scan area.

Select [Scan and Focus Logic].

 Focusing and scanning only the specimens inside the area. 
The processing speed is faster, but areas not recognized as 
specimen will not be scanned.

 Scanning the whole area and focusing only on the specimen. 
Areas not recognized as specimens will not be focused.

 Scanning and focusing the whole area. 
Even for specimens that are hard to recognize all areas will 
be focused.

After editing, click  (confirm input) and confirm the scan area. 

1

2

3

4

The scan area can be edited and a new scan area can be created.

2

1

3

4
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4-9 Editing focus maps

Select the [Focus Settings] tab and click .

The [Edit Focus Map] window is displayed.

Select the focus map grid density.

Edit the focus map in the edit window. 

Add: Left-click to add . 

Delete: Right-click  and select [Delete] from the menu. 

Move: Drag  to the point where you want to move it.

In expert (brightfield / fluorescence) mode, the focus mode 

can be set. For more details, please refer to the following page 

“4-10 Setting focus mode”.

After editing the focus map, if you click on another grid 
density you will lose those changes.

After editing, click  (confirm input) on the left side of the editing 

screen and confirm the scan area.

1

2

3

TIP

NOTE

4

3

The focus point position and grid density can be edited.

4

2
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4-10 Setting focus mode

Select either ,  or  from the [Focus Logic] in the [Focus 

Settings] step.

·· : [Automatic focusing]

Auto focus is enabled. Subsequent steps are not required.

·· : [Semi-automatic focusing]
After auto focus, focus is adjusted manually.

·· : [Manual focusing]
Focus is adjusted manually.

Adjust the focus.

 Turn the joystick focus dial.

 Press the keyboard [Ctrl] key, and turn the mouse wheel when 

the mouse cursor appear as Z ( ).

Click  (next focus map) or  (previous focus map) and repeat 

2 . You can also left-click the mouse while holding down Ctrl to 

move to the next focus map.

In the case of samples with low contrast or using high 
magnification oil objective lens which the auto focus is 
not appropriate, please select semi-auto or manual mode 
and check the focus before scanning.

For more details on focus logic lease, refer to the Online Help.

1

2

3

NOTE

TIP

In expert (brightfield / fluorescence) mode, the focus logic (method for focusing) can be set for each slide.

L100 type 
S5 type

S6 type
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4-11 Priority scanning

During image acquisition in batch mode, image of slides that have not 

been set on the slide loader or stage can be acquired without waiting for 

the other slides to finish.

When acquiring image of the priority slides is complete, the batch mode 

image acquisition will restart from the point at which it was interrupted.

Before starting a priority scan, in order to ensure the safe 

pausing of the batch mode image acquisition in progress, 

there may be a need for a certain amount of time.

Click .

Click ,  or  to 

start the scan.

·· The procedure for priority scanning is the same for “Quick 
mode", “Expert mode" and “Fluorescence expert mode" for your 
model type.

·· Please confirm in the scan wizard top screen whether the 
priority scan is in process or not.

If you wish to continue the paused batch, click .

If you wish to cancel the paused batch, click .

If you click , the scan settings of the 
paused slides will be lost and the batch scan will not be 
able to be restarted.

For more details, please refer to the Online Help.

TIP

1

2

TIP

3

NOTE

3

1

2
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4-12 Operating each fluorescence channel

If checked, the contrast of the live image and the overview 

image on the screen will be adjusted automatically.

If you adjust manually, uncheck the checkbox and adjust the 

histogram. For procedures to adjust the histogram, refer to 

“Adjusting histogram after acquiring image”on page 77.

Removal of online deblur
Makes the live image clearer.

Enabled when you select [Tissue] or [Cells] in overview.

Saturation indicator
Display the saturation indicator or pseudo color table in the live 
image. The saturation indicator displays low intensity as blue, 
high intensity as red, and the pseudo color table display refers 
to the settings of the color table.

Enabled when you select [Tissue], [Cells] or [Channels].

·· The adjusted image does not affect the actual image, only the 
display in the screen is changed.

·· The display adjustment values will be saved in both [Quick 
mode] and [Expert mode] until you exit VS-ASW.

·· The auto exposure time mode adjustment value can be 
managed in scan project.

TIP

TIP

TIP

Overview screen

Illumination settings screen

Adjust the resolution of the fluorescence image.

Resolution can be adjusted in the overview screen and illumination settings 

screen in fluorescence mode.

1 	 Adjusting exposure time
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Set how much other channels are offset when scanning based on a channel.

Click  to enable Z offset mode.

Click .

The [Detect Z offset] window and live image are displayed.

Confirm that the focus is adjusted and click .

When all the settings are completed, the Z offset value of all 

channels will be displayed.

Click .

The Z offset value of the No.1 channel is always 0.

1

2

3

TIP

2 	 Setting Z offset

2

1

3
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Selecting channels

Click the [Layers] icon channel and you can select whether to 

display or not.  

Also, it can be displayed in grayscale.

For more details, please refer to the Online Help.

Adjusting histogram

You can change the value of the intensity in the [Adjust Display] tool 

dialog box.

Select the channel with 1  and adjust the histogram.

: Select [Fixed Scaling], and enter the left and right numeric values.

In the case of a 16-bit camera it should be [Left: 0 

Right: 65536].

: When you select auto contrast, contrast is adjusted automatically. 

By setting each color, you can optimize viewing.

Operating the histogram

Scaling the X axis

	Method 1: 	Enlarge or shrink by clicking  and .

 Method 2: 	Select the chart (left-click on the chart), and enlarge 

or shrink by scrolling the mouse.

Moving the X-axis left and right

	Method 1: 	Select the chart, and move the mouse to the left or 

right while holding down the left mouse button.

 Method 2:	 Left and right movement with the scroll bar.

Default display of the histogram

 Choose the camera to be used from the pull-down menu.

1

2

TIP

1

2

3  	 Adjusting histogram after acquiring image
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5 Using Scan Projects 

5-1 Saving scan projects

Save detailed acquisition settings such as the scan area, and then use for subsequent image acquisition.

For more details on scan projects, please refer to the Online Help.TIP

On the scan exit screen, click .

The [Save Scan Project As] window is displayed.

Enter a filename, set the access permission, and click .

·· Scan projects can also be saved on the screen before starting 
the scan.

·· The file can be saved as private or public. Private files will only 
appear in the current Windows Login account. Public files will 
appear in all Windows Login accounts.  
In addition, you can only use “Restoring the System" for scan 
projects that were saved publicly.  
For more details, please refer to “8 Saving and Restoring the 
System” on page 96.

1

2

TIP

2

1
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Display the [Scan Projects] tab.

Select the scan project to load from the list of saved scan projects.

Click .

The scan settings are loaded.

1

2

3

5-2 Loading scan projects

Display the [Scan Projects] tab.

Select the scan project to edit from the list of saved scan projects.

Click .

The [Scan Project Editor] window is displayed.

Set the required items and click . 

The changed items are saved.

Click .

1

2

3

4

5

5-3 Editing scan projects

3
2

4 5

Click the scan settings screen  (import scan project).

Select the scan project to load from the list of saved scan projects in 

the [Import Scan Settings from Project] dialog box.

Click .

The scan settings are loaded.

1

2

3
1

Single scan mode

Batch scan mode

1

32

1
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6 Editing Images 

6-1 Trimming images and saving as TIFF

When saving acquired images in TIFF format, large images and high-resolution images may be altered when saved. In this 

case, save the TIFF file after trimming the unnecessary parts.

6-2 Copying and transferring images to other mediums

From the [Images] menu, select [Crop to New Image] or select .

Trim the unnecessary parts of the image.

From the [File] menu, select [Save As].

The [Save Image As] dialog box is displayed.

Select [TIF] as the file type, and click .

There are 4 methods for trimming. 

For more details, please refer to the Online Help.

1

2

3

4

TIP

The file size in VSI format may become very large due to the unlimited image size. 

If you copy or move the image, use NTFS of the file system of the hard disk of save destination, which has a larger capacity.

A VSI file with the same name as the file folder is created 
within the folder. To copy VSI files in Windows Explorer, 
please copy and move both the file and folder names.

NOTE

2

VSI file

Directory

3

1

4
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6-3 Changing image names

Click [Rename VSI Files] from the [File] menu.

The [Rename VSI Files] dialog box is displayed.

Click  and select the folder in which the image 

is saved.

Select the file you wish to change and left-click to change the name.

Click .

A VSI file with the same name as the file folder is created 
within the folder. To change the name of VSI files in 
Windows Explorer, please change both the file and folder 
names.

Click .

1

2

3

4

NOTE

5

2

1

3

4

5
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7 Maintenance

If you are using the VS120 system for a long period of time, there 
may be times when the brightness of the image is not uniform. This is 
called shading.
When shading occurs, virtual slide images will be in the state as 
shown on the left. In such a case, by performing calibration, equal 
brightness of the image will be restored.

Set the slide specimen in the stage.

In shading correction, transparent areas (an area where 
there is no cell or tissue) use a wide slide.  
Please ensure that the slide specimen is clean with no 
dust or dirt.  
Also, for other items of caution, please check the wizard 
screen "Notes".

Click .

Select [Acquire]→[Calibration].

The [Calibration] window is displayed

Select [Shading Correction] and click .

1

NOTE

2

3

4

7-1 Shading correction

Virtual slide image with shading applied.

1 	 Brightfieldcamera shading correction

4

2

3



VS120

83

Maintenance 	 Brightfieldcamera shading correction

5

The screen on the left is displayed. Confirm that BF is checked and 

click .

The [Shading Correction] window is displayed.

·· If you do not require the incorporation of a parasitic current 
correction image, please check the checkbox.

·· For weak fluorescence images, where the effect of parasitic 
current noise is large, please remove the check.

Click .

The [Calibration] window displays again. 

Select the objective lens (magnification) to be adjusted and items 

and click .

Normally, select all items when calibrating. Click <Select All> to 

check all the magnification and item checkboxes.

5

6

TIP

7

TIP

6

7
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Calibrate a 2x objective lens.

While watching the live image, after adjusting the focus of the 

slides, move the stage, to move the slide specimen outside the 

observation range of the objective lens.

Confirm that nothing is showing in the live image and click .

If dirt or dust shows in the live image, please clean the 
objective lens or condenser lens.  
For cleaning methods, please check  the instruction manual 
[Hardware] “Maintenance and preservation” and for other 
items of caution, please check the wizard screen “Notes".

10x, 20x and 40x objective lens calibration follows the same procedure.

Please perform calibration on the cover glass ensuring 
that there are no specimens or dust / dirt. 

When all selected objective lenses (magnification) are complete 

“Calibration finished!" is displayed. The screen is displayed.  

Click  and calibration is complete.

Using “Saving and Restoring the System", [Shading Correction] 

can be easily restored according to the observed objects.  

For more details, please refer to “8 Saving and Restoring the 

System” on page 96.

8

NOTE

NOTE

9

TIP

[Live image]

9

8



VS120

85

Maintenance 	 Fluorescencecamera shading correction

·· This function assumes that an ORCA-Flash4.0 
fluorescence camera is used. If another camera is used 
the intended results may not be obtained.

·· Since it depends on the specimen, correction may be 
insufficient, or may make the image worse, depending on 
the specimen.

·· When the software is updated, discard the fluorescence 
shading correction and redo it.

First, set a specimen to use for the fluorescence shading correction on 

the stage.

Perform shading correction from the menu command

The [Camera Control] window is displayed under the [View] menu 

→[Tool] window.

If the light source is Xcite Exacte or SOLA SE II, please also 

display the [Microscope Control] window in the [View]→[Tools] 

window.

Click .

Select [Acquire]→[Calibration].

The [Calibration] window is displayed.

Select [Shading Correction] and click .

Check the checkbox for the observation method to be adjusted and 

click .

NOTE

1

TIP

2

3

4

5

2 	 Fluorescencecamera shading correction

4

1 2

5

3
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The [Shading Correction] window is displayed.

If you do not require the incorporation of a parasitic current 

correction image, please check the checkbox.

Click .

If the checkbox is unchecked:

The [Shading Correction - Dark current] window is displayed.

Confirm the screen contents and click .

Select the objective lens (magnification) to be adjusted, choose [Special] 

from the 2 calibration methods, and click .

The objective lenses (magnification) will be corrected from the 

lowest magnification lens.

6

TIP

7

TIP

6

7

6

6
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The “Preparations" message screen is displayed.

Adjust the slide following the instructions on the screen.

·· Please acquire an image on the tissue or cell.

·· Please do not use a 2x objective lens because satisfactory 
results cannot be obtained.

·· Confirm whether the specimen is in focus on the live 
image, and if not in focus, use the joystick focus dial to 
adjust the focus.

Use the specimen where the fluorescence is emitted entirely in the 

area 1.6 times of the live image field-of-view and also the sizes of cell 

holes (non-fluorescence areas) in the field-of-view meet the following 

conditions.

Objective lens  10x	: diameter 350 µm or less 
Objective lens  20x	: diameter180 µm or less 
Objective lens  40x	: diameter 90 µm or less 
Objective lens  60x	: diameter 60 µm or less 
Objective lens100x	: diameter 35 µm or less

Confirming conditions:

·· Using an objective lens (magnification) with 1 step lower 

magnification than the objective lens (magnification) used 

to acquire the image, please confirm whether the above 

conditions are met.

·· The objective lens below 60x is a dry objective lens, please 

confirm after moving the stage.

(Please measure the hole's approximate size using the "Scale" 

on the screen lower right.)

After confirming the conditions please do not forget 
to return to the original magnification objective lens 
(magnification). 

Adjust the exposure time in the [Camera Control] window.

Select exposure settings [Auto], gradually increase the brightness of 

the light source, and adjust the light on the illumination side until the 

exposure time is approximately 1 second (1000 ms).

If it is difficult to adjust the exposure time to approximately 

1 second, please set the light to its maximum.

After adjustment, click .

Shading correction is performed for the selected objective lens 

(magnification).

Shading correction is performed sequentially for the objective 

lens selected in and 7 . Please confirm the [Current 

Objective].

For more details, please refer to the Online Help.

8

NOTE

TIP

NOTE

TIP

TIP

Hole sizes which do not meet the conditions 
on the right.

8
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When all selected objective lenses (magnification) are complete 

“Calibration finished!" is displayed. A message screen is displayed.

Click  and calibration is complete.

Using “Saving and Restoring the System", [Shading 

Correction] can be easily restored according to the observed 

objects.  

For more details, please refer to “8 Saving and Restoring the 

System” on page 96.

Deleting shading images

Delete unrequired shading images.

Select [Acquire]→[Calibration].

The [Calibration] window is displayed.

Select [Shading Correction] and click .

The [Edit Shading Images] dialog box is displayed.

Select the image to be deleted, click , and when 

complete, click .

Two types of shading image are acquired with the same 
name for each objective lens. When deleting, please delete 
both types.

9

TIP

1

2

3

NOTE

9

2

3

1
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Perform shading correction during scan wizard image acquisition

Please perform fluorescence shading correction with the wizard only 

when you have sufficiently understood the contents.  

It is recommended to save the setting before implementation. For more 

details, please refer to “8-1 Saving the system” on page 96.

The [Camera Control] window is displayed under the [View] menu 

→[Tools] window.

If the light source is Xcite Exacte or SOLA SE II, please also 

display the [Microscope Control] window in the [View]→[Tools] 

window.  

Fluorescence shading correction is performed for the selected 

observation method.

At the scan wizard [Illumination Settings] step, click .

The [Shading Correction] window is displayed.

If you do not require the incorporation of a parasitic current 

correction image, please check the checkbox.

Click .

Select the objective lens (magnification) to be adjusted, choose 

[Special] from the 2 calibration methods, and click .

The objective lenses (magnification) will be corrected from the 

lowest magnification lens.

1

TIP

2

3

TIP

4

TIP

3

4

2

1
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5

The “Preparations" message screen is displayed.

Adjust the slide following the instructions on the screen.

·· Please acquire an image on the tissue or cell.

·· Please do not use a 2x objective lens because satisfactory 
results cannot be obtained.

·· Confirm whether the specimen is in focus on the live 
image, and if not in focus, use the joystick focus dial to 
adjust the focus.

Use the specimen where the fluorescence is emitted entirely in the 

area 1.6 times of the live image field-of-view and also the sizes of cell 

holes (non-fluorescence areas) in the field-of-view meet the following 

conditions.

Objective lens  10x	: diameter 350 µm or less 
Objective lens  20x	: diameter180 µm or less 
Objective lens  40x	: diameter 90 µm or less 
Objective lens  60x	: diameter 60 µm or less 
Objective lens100x	: diameter 35 µm or less

Confirming conditions:

·· Using an objective lens (magnification) with 1 step lower 

magnification than the objective lens (magnification) used 

to acquire the image, please confirm whether the above 

conditions are met.

·· The objective lens below 60x is a dry objective lens, please 

confirm after moving the stage.

(Please measure the hole's approximate size using the "Scale" 

on the screen lower right.)

After confirming the conditions please do not forget 
to return to the original magnification objective lens 
(magnification).

Adjust the exposure time in the [Camera Control] window.

Settings [Auto], gradually increase the brightness of the light source, 

and adjust the light on the illumination side until the exposure time 

is approximately 1 second (1000 ms).

If it is difficult to adjust the exposure time to approximately 

1 second, please set the light to its maximum.

After adjustment, click .

Shading correction is performed for the selected objective lens 

(magnification).

5

NOTE

TIP

NOTE

TIP

Hole sizes which do not meet the conditions 
on the right.
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6

When all selected objective lenses (magnification) are complete 

“Calibration finished!" is displayed. A message screen is displayed.

Click  and calibration is complete.

Using “Saving and Restoring the System", [Shading 

Correction] can be easily restored according to the observed 

objects.  

For more details, please refer to “8 Saving and Restoring the 

System” on page 96.

6

TIP
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7-2 Setting overview image area

Set the slide in the stage.

Only when using S5 type / S6 type, select the slide for which you will 

set the image area in the [Stage Navigator] tool window. The selected 

slide is highlighted in color.

(When using L100 type, go to step 3  .)

Click  (define overview area) in the [Stage Navigator] tool window.

You can also change the settings by selecting [Define 

Overview Area] from [Acquire]→[Calibration] menu.

The lowest magnification objective lens (magnification) is engaged.

The live-image will be displayed.

1

2

3

TIP

3

Set the slide area for acquiring overview images.

Please set the image area of the whole slide. 

The overview image area, once set, will not change until the next image area is set.

TIP

L100 type

S5 type/S6 type

3 2
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The [Define overview area] dialog box is displayed. 

Use the joystick lever to move the stage to the  position shown in 

the figure below. When the position is determined, click .

VS120-L100-W VS120-S5-W

VS120-S6-W

The [Define overview area] dialog box is displayed. 

Use the joystick lever to move the stage to the  position shown in 

the figure below. When the position is determined, click .

VS120-L100-W VS120-S5-W

VS120-S6-W

It is recommended to set the overview image area so that it 

includes the entire specimen or the entire cover glass.

4

5

TIP

4

5

Label

Label
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7-3 Setting label area

Set the slide in the stage.

Only when using S5 type / S6 type, select the slide for which you will 

set the label area in the [Stage Navigator] tool window. The selected 

slide is highlighted in color.

(When using L100 type, go to step 3  .)

Select [Acquire]→[Calibration].

The [Calibration] window is displayed.

Choose [Define Label Area] and click .

The lowest magnification objective lens (magnification) is engaged.

The live-image will be displayed.

1

2

3

4

4

S5 type/S6 type

When scanning labels, set the stage movement range. 

2

3
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4

5

The [Define label area] dialog box is displayed. 

Use the joystick lever to move the stage to the   position shown in 

the figure below. When the position is determined, click .

VS120-L100-W VS120-S5-W

VS120-S6-W

The [Define label area] dialog box is displayed. 

Use the joystick lever to move the stage to the   position shown in 

the figure below. When the position is determined, click .

VS120-L100-W VS120-S5-W

VS120-S6-W

4

5

Label

Label
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8 Saving and Restoring the System 

8-1 Saving the system

System status can be saved and restored in this System.

This function is available only when the Windows account is Administrator. 

"Settings" can be saved, not images.

When the software is updated, restore points made with the previous version will not be able to be 
read.

TIP

NOTE

Start [VS-ASW].

Select [Acquire]→[Device].

Click [Create System Restore Point...], confirm the displayed message 

and click .

Specify the save destination for the system information, input the file 

name and click .

[VS-ASW] automatically restarts.

The following information can be saved.

·· Calibration information

·· Device list

·· Device settings

·· Contents of all settings saved publicly

·· ScanProject contents

·· Layout position of each Tool Windows

1

2

3

4

5

TIP

8-2 Restoring the system

Start [VS-ASW].

Select [Acquire]→[Device].

Click [Restore System Restore Point...], confirm the displayed message 

and click .

If there are multiple restore points, select a file and click .

[VS-ASW] automatically restarts.

1

2

3

4

5

4

2

3

3

2
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